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9 POWERPOINT PRESENTATIONS 
Creating slide shows and related teaching 
materials 

 

LEARNING OUTCOMES 
This lesson introduces you to the basic features of PowerPoint which are particularly valuable in 
the teaching and learning environment. You will learn how to use PowerPoint to capture your 
ideas in outline form and convert those ideas into multimedia presentations. You will also learn 
how to use the application to create your own presentations both from scratch and with the help 
of one of the PowerPoint Wizards. 

Most people think of a slide show as a way of presenting a series of still images or 
photographs using a slide projector. If you think about it, however, a slide does not have to be a 
still image; using PowerPoint it can also be an audio or video clip. For that matter, a slide does 
not have to be even a picture; it can also be text, an outline of ideas, whatever you want. 

PowerPoint provides an easy-to-use multimedia presentation production system, which you 
will no doubt enjoy learning and which you and your students will find useful for individual or 
group projects of all kinds. 

In the various courses that you take as an Education major you learn how to design curricula, 
with lesson plans and unit plans. You also learn methodologies for effective teaching. The better 
the teacher you are, the more PowerPoint will empower you in your work. 
Here, then, are the topics that will be covered in this lesson: 

• 
• 
• 
• 
• 
• 

introductory thoughts about presentations; 
PowerPoint at work; 
building the presentation; 
adding bells and whistles to the presentation; 
hiding slides and using Action Buttons; 
printing presentation handouts. 

A caveat before you begin: 
Till now, the steps to accomplish the tasks assigned have been rather detailed. This time, 
however, the directions will be less specific, especially in the latter half of the lesson, because 
PowerPoint is a program you can figure out by playing with it. You’ll find that you’ll soon 
become confident about how to design and develop high quality multimedia slide presentations. 
So relax, and have fun! 



ESSENTIAL MICROSOFT OFFICE XP: Tutorial for Teachers 
Copyright © Bernard Poole, Lorrie Jackson, Rebecca Randall, 2002. All rights reserved 

 
244 

9.1 SOME INTRODUCTORY THOUGHTS ABOUT PRESENTATIONS 
Making a successful—well-designed, content-rich, pedagogically-sound—PowerPoint 
presentation requires forethought and advance preparation. A presentation, like a term paper, is 
usually based on an outline such as is illustrated in Fig. 9.1 and Fig. 9.13 later in the lesson. 

 

The selected 
slide in the 

Outline is shown 
here so you can 

check it out 

Each slide icon 
indicates a new 

slide in the show

Slide View toolbar 

Fig. 9.1 Outline (Normal View) for the Tudor Monarchs presentation (annotated) 
Take a good look at Fig. 9.1—study the annotations especially 
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You see on the left an outline of the text for each slide in the Tudor Monarchs presentation. 
Compare the titles and text for each slide to an outline you would have made for a high school or 
college paper. Similar, right? This is why the outlining tool is built into PowerPoint—to help 
you plan. 

Remember the golden rules of successful design: Rule 1—Plan; Rule 2—Plan; Rule 3—
Plan! These golden rules apply whether you are designing a term paper, an audio-visual aid, a 
class outing, or a class syllabus and schedule. 

You might begin with a brainstorming session to help you get an outline. During 
brainstorming, members of the group would come up with as many ideas as possible related to 
the topic of the project. Nobody's ideas are rejected in the early stages so as to encourage a fertile 
flow of useful suggestions. 

The result of the brainstorming session might be a somewhat disorganized list of ideas. This 
list might have been entered directly into the computer during the brainstorming session, or it 
might have been collected on a blackboard or flip chart. Before changing the list into outline 
form you would re-organize it so that the ideas flowed naturally and logically from one to the 
other. Along the way you might toss out some of the ideas for one reason or another. Eventually 
you'll have a working list which would end up as an outline, perhaps in a word processor 
document. 
 
9.2 POWERPOINT AT WORK 
Let’s see these ideas and others at work by looking at an example of a PowerPoint presentation. 

Turn on your computer and open PowerPoint  
Showing the Full menus and organizing the Toolbars 
In case you're using a computer in a lab or some computer other than your own, you should set 
the options to Always show full menus, Show the Standard and formatting toolbars on two rows, 
List font names in their own font, and Show ScreenTips on toolbars. 

You may recall doing this at the beginning of all the previous lessons. If the computer you're 
using doesn't already have these settings, here's what you do. 

In the Tools menu, select Customize…, and in the dialog box that pops up, 
select the Options tab (Fig. 9.2) 

 
Fig. 9.2 The Customize dialog box 
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Make sure there is a check mark next to the item to Always show full menus 
While you're at it, check the box next to Show Standard and Formatting toolbars 
on two rows, List font names in their font, and Show ScreenTips on toolbars 
Click the Close button when you're ready 

On with the tutorial… 
In the New Presentation Task Pane, click on Presentations… (might be 
More Presentations…) (Fig. 9.3) 

 
Fig. 9.3 The New Presentation Task Pane 

PowerPoint now presents you with the Open dialog box (Fig. 9.4) 

 
Fig. 9.4 The Open dialog box 
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In the Open dialog box, locate on your PowerPoint disk the document Tudor 
Monarchs, then Open the document 

Fig. 9.5 shows the Tudor Monarchs presentation in Normal View as it appears on your screen 
right after you open the document. 

 

 
Slide View tools 

Fig. 9.5 The Tudor Monarchs presentation 

Take a look at the Slide View tools in the lower left corner of the PowerPoint window (Fig. 9.5). 
You'll use these tools a lot while you're developing your slides, so let's get a close up view of 
them right away and find out what each of them is about (Fig. 9.6). 

 
Fig. 9.6 The Slide View toolbar (annotated) 
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Normal view 
This is the view you see illustrated in Fig. 9.5 on the previous page. It is the one you'll use most 
of the time while you're actually putting information on each slide. In this view you have the left 
hand frame where you have the option to either see a thumbnail of all your slides or the outline 
for your presentation. In the center of the window you have the slide you are actually working 
on—the active slide. 

Slide Sorter view 
This is the view you see illustrated in Fig. 9.7 on the next page and it is the one you'll find most 
useful when you want to get an overview of your show since you'll be able to see most all your 
slides at once. You also can easily move your slides around, changing the order to suit your 
purposes. 

This is why it's called the Slide Sorter view. 

 

The Slide View 
toolbar 

Fig. 9.7 The Slide Sorter View of the Presentation 

Slide Show view 
When you click on this button, you'll be able to see how the slide you're actually working on (the 
current or active slide) looks when you run the slide show.  You'll use this button when you've 
been working on a slide for a while and you want to see how it will look to your audience. 

You'll find yourself using these tools frequently to switch from one view to another as you 
are developing your PowerPoint presentation. 

Let's check out the Slide Sorter view now. 



Lesson 9: PowerPoint presentations 249

Click on the Slide Sorter tool in the Slide View toolbar (you can also access 
these views from the View menu, by the way) 

Take a look at the Slide Sorter View window that is presented to you now (more or less the same 
as Fig. 9.7 on the previous page, though your screen may be a different width, so the slides may 
be arranged differently across the page). 

The presentation you are looking at was created to demonstrate some of the basic features of 
PowerPoint. By the end of this lesson you will be able to build your own presentations along the 
same lines. 
Features to look out for in the demonstration presentation 
While you click your way through the presentation, look out for the following PowerPoint 
features that have been used in its creation. 
Transition effects and text preset animations 
The transition effects from one slide to another and the text preset animations (which determine 
how the text will arrive on each slide) have been set at random for the demonstration. This is so 
that you get an idea of the variety of transitions and animations you can use in PowerPoint. 
Normally you would not want to use so many different transitions and animations since it might 
distract from the impact you are trying to make. A good designer homes in on a style that he or 
she likes best for a particular theme and tends to stay with it for all the slides in the show. 

The World Wide Web as a source of information 
The illustrations and other information for the Tudor Monarchs presentation all came from Lara 
Eakins' beautiful website devoted to the Tudors (http://tudorhistory.org). You should take time to 
visit this site in order to discover the information-rich websites that are available to your present 
and future students. 

You'll notice the reasonably high quality of the illustrations in the demonstration 
presentation. All the applications in the Microsoft Office suite of programs, including 
PowerPoint, have a web toolbar within the program itself that makes it easy for you to locate and 
download educational material from the web. 

Let's take a look at this toolbar now. 

In the View menu select Toolbars, and from the sub-menu click to select 
Web to display PowerPoint's web toolbar (Fig. 9.8) along with the other 
toolbars on the screen 

 
Fig. 9.8 The PowerPoint toolbar and the Web toolbar 

Inserting clip art, pictures, and other media 
Microsoft Corporation maintains a rich database of clip art on a wide range of topics. This 
online database is available to all the programs in the Microsoft Office suite. You just have to go 
to the web to access it if you are a registered user of the Office or other Microsoft programs. 
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Fig. 9.9 illustrates the Insert menu from which you can choose to include clip art and other 
media (such as photos, movie clips, sound files, and so forth). 

 

Fig. 9.9 Inserting clip art and other media 

Take a closer look at Fig. 9.9, or in the Insert menu select Picture, to see 
what options are available to you in the Picture sub-menu for inserting 
images onto the slides in your presentation 

Notice, in the Insert menu, the Movies and Sounds options, too 

You can download clip art and other media from a file you have saved on disk, or you can bring 
onto a slide all kinds of charts and tables from other Office programs such as Word or Excel.  

You can even scan pictures directly onto a slide, so if you have a scanner connected to your 
computer, you’re in business. If you’re looking for multimedia material to accompany your 
slides, today's online computer in general, and PowerPoint in particular, make this as easy as 
possible to do. 

Buttons and Hidden Slides 
Notice the use of buttons to allow the user control movement through the slides. There also is a 
Hidden Slide (slide #5) which is only seen if you click on the button to see the answer to the 
question posed on slide #4. 

This shows you that you can create some very interesting interactive learning materials using 
PowerPoint. Lesson 10 will give you the opportunity to learn how to create interactive 
presentations such as this. Your students, too, will have a ball using this software to develop 
projects of all kinds for every subject under the sun. 
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Timing considerations 
If you look again at Fig. 9.7 on page 248, you’ll notice that under each slide is a number on the 
right, indicating which slide it is, and a ":30" on the left, showing that the slide will transition to 
the next in 30 seconds. 
Now, 30 seconds is more than enough time for anyone to read and absorb the data on slides such 
as those in the Tudor Monarchs presentation. So you might think 30 seconds is too long to hold 
the user’s attention. Won’t they get antsy waiting for the next slide? 

Well, if you look at each of the slides, you will see that there is a button which the user can 
click on to control when to proceed to the next slide. Thus, by allowing a generous amount of 
time, along with user control, you're allowing each individual the freedom to proceed at his or 
her own pace. The speed at which our minds absorb data varies enormously from person to 
person. 

You always want to design teaching materials and lessons in such a way as to address 
individual student needs. 

Always give credit where credit is due 
The last slide in any presentation, just as the last item in a term paper, should always be your list 
of sources cited or used (Fig. 9.10). 

 
Fig. 9.10 The Acknowledgements slide 

It is time you learned about the Tudor Kings and Queens of England. 
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In the Slide View toolbar, click on the Slide Show button (or from the Slide 
Show menu, select View Show) 
Now… If you haven't already done so, click your way through the presentation 
now (you can click the left button on your mouse to do this, or hit the space 
bar, or use the arrow keys to go back and forth, or click on the Action 
Buttons on the slides themselves to proceed to the next or previous slide) 

The slides have been timed to allow the user to easily view and read what is on each slide 
without feeling rushed. If you want the slides to proceed at a faster pace, simply click on the left 
mouse button or hit the space bar. 

When you have finished reviewing the Tudor Monarchs slide show, exit the 
show by right clicking the mouse, then select the last menu item to End 
Show 

So much for an overview of PowerPoint. No doubt you are anxious to start creating your own 
presentation. The next section will help you do just that. 

Close the Tudor Monarchs presentation when you are ready to continue with 
the tutorial 

 
9.3 BUILDING THE PRESENTATION 
Preparation of the outline 
You are going to prepare a simple outline (Fig. 9.11) which will give you the experience to 
prepare your own outlines when you're done with the tutorials. 

It's tempting to just barrel along into a presentation, like someone tempting fate at Niagara 
Falls!  But you should resist doing so at all costs because you'll save yourself no end of time in 
the long run if you carefully plan what you want to do. You really have to think ahead if you 
want to get where you want to go. Otherwise, there's no telling where you'll end up! 

To create an outline, here are the steps to follow. 

From the File menu select New... and in the New Presentation Task Pane, 
click on Blank Presentation (Fig. 9.11) 
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Fig. 9.11 New Presentation Task Pane 

When you first open a new, blank presentation in PowerPoint XP, the program presents you with 
the Normal View (Fig. 9.12), with the Slide Layout Task Pane on the right. 

 

Click on either of 
these tabs to switch 

from Outline to Slide 
thumbnail view and 

vice versa 

This is the active slide 
layout for a Title slide to 
start your presentation 

These sets of  Slide Layout 
templates will help you put 
together slide designs that 

will meet most of your 
needs 

View thumbnails 
of your slides in 

this left hand pane, 
or click on the 
Outline Tab to 
work with your 

Outline 

Slide View 
toolbar You can add notes here to 

accompany each slide 

Fig. 9.12 The screen at the start of a new blank presentation 

Take a close look at the various parts of this opening screen—be sure to 
read each of the annotations before moving on 

As you can see, PowerPoint provides a lot of help while you're developing your presentation. 
The first slide layout is the Title slide layout by default. This is because you would normally 

want to start out a presentation with a slide that displays the title of your show, along with sub 
titles such as your name and so forth. You don't have to use these slide layouts, of course.  You 
can create slides from scratch, entirely of your own design, in which case you would select the 
blank slide layout, which is the first of the Content Layout slide templates.  

Typing the outline entries 
Right now you need the Outline view in the left hand pane, in order to start work on the outline. 
As you will see, the outline will be merged into the slide show with little effort on your part, 
thanks to PowerPoint’s slide layout features. 
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Click on the Outline tab at the top of the left hand pane 
PowerPoint now presents the Outline view (Fig. 9.13), with a small slide icon in the top left 
corner, waiting for you to begin entering the text for your slides. 

 

Start typing your 
outline here 

Fig. 9.13 The Outline view in the left hand pane 
Before you begin, however, you should save the presentation with an appropriate name so that 
you can easily save your work as you go along. Remember, this is always a wise precaution. 
Giving a new document a name and saving it on your disk helps you to get into good habits 
about saving your work. You should teach your students to be equally careful when they are 
developing work on a computer. 

Make sure you have your Data Disk in the drive, then from the File menu 
select Save As, call the document Screenbeans, select the drive for your 
disk, and click on Save 

Here is the outline you are going to create (Fig. 9.14). 
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Fig. 9.14 The outline for the Screenbeans presentation 

For the first slide, type the title No Problems, Only Solutions next to the first 
slide icon (see Fig. 9.14) and hit enter 

Now then. Notice that PowerPoint thinks you want a whole new slide (you can see a new slide 
icon next in the Outline). But you want to stay on the first slide because you need to put your 
name as a sub-title.  To do this you need to switch levels in the Outline. 
Switching levels in an Outline 
Switching levels means moving up or down in the hierarchy of topics on each slide.  For 
example, you might have a top level topic such as Disasters, then as sub topics you might have 
Earthquakes, followed by Volcanoes, followed by Forest Fire, and so forth.  If you look at the 
second slide in Fig. 9.14, the word Confusion is at the top level, then what immediately 
follows—indented—is lower level text A problem often presents itself…, etc. When you switch 
to the next level down (called demoting), the text is automatically indented to the right. 

So, to summarize, moving the text to the left takes you up a level in an outline, which is 
called promoting. Moving the text to the right takes you down a level in an outline—called 
demoting. 
Moving (demoting) text to a lower level 
For the remaining slides you have to enter text not only for the Title of each slide at the top level, 
but also for the text placeholder (see Fig. 9.16). This text will be at a lower level than the title. 
To change levels in an outline, PowerPoint provides outlining tools (Fig. 9.15). 

 
Fig. 9.15 The Outline Control tools 

Here are the steps to display this Outlining toolbar on the left side of the window so you can 
easily get to it when you need to work on your outline. 

In the View menu, select Toolbars and in the sub-menu select Outlining 
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Remember where to find the Outlining tools.  You should have them on the screen as a matter of 
course whenever you set out to work on a PowerPoint presentation. 

Now, in the Outline Control tools (Fig. 9.15), click on the second arrow 
down to demote to a lower level the next text that you’re going to type into 
the outline 

Look at your outline now and notice that the next entry you type will be indented and perhaps 
bulleted, too. 

Type by [your name] and hit Enter 
Raising (promoting) text to a higher level 
Look at your outline again and notice that the next entry you type will still be indented and 
bulleted on the same slide—slide #1. But you want to start a new slide in the Outline.  To do 
this, you must switch levels again, this time promoting to a higher level. 

Click on the top arrow in the Outline Control tools (Fig. 9.15) to promote the 
next text item to the top level for the 2nd slide 

As you see, this takes you up one level. Now you are at Level 1 of your outline, still on the same 
line, but you’ll be working on a new slide—slide #2. 

Type Confusion for the title of the second slide, then hit Enter 
In the Outline Control tools (Fig. 9.15), click on the second arrow down to 
demote to a lower level the next text that you’re going to type into the outline 
Type the lower level text for the second slide (A problem often…) from the 
illustration in Fig. 9.14 on page 221, then hit Enter 

That is all you need to do for the second slide for now. You will add pictures in a moment. But 
first you should complete the text outline. As you can see, you need to promote the next text item 
back to the top level for slide #3. You will use the Outline control tools once more. 

You should be starting to get the hang of this by now, especially if you have already 
completed the eight preceding tutorials! Indeed, you should be starting to think of yourself as 
something of an expert with Microsoft Office in general, and with the various Office tools like 
PowerPoint in particular. 

So go ahead now and type the rest of the outline (using Fig. 9.14 on p. 
254), promoting and demoting the text levels as you go along 

When you have typed the title and text entries for slide #9, be sure to save 
your work again with the document name Screenbeans 

Now, before you go on, in the left hand pane, click on the Slides tab so you 
can see the thumbnails of all your slides 

Neat, huh? PowerPoint has selected the simple Title and Text slide layout since a title and some 
text is all you have on each slide thus far. But now you need to select a different slide layout for 
all the slides after the first slide because you are going to add a picture to each one. 

Click on the thumbnail for Slide #2, then in the Format menu select Slide 
Layout… 
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In the Slide Layout Task Pane on the right of your screen, locate the Text 
and Content Layouts section of the Slide layouts 

In the Text and Content Layouts, locate and double click on the layout for 
Title, Text, and Content (Fig. 9.16) 

 

Title, Text, and 
Content slide 

layout 

Fig. 9.16 The Title, Text, and Content slide layout 
The new layout (Fig. 9.17) lets you to put a title at the top of the slide, some clip art in the lower 
left placeholder, and text in the lower right placeholder. 

 

The Content 
Placeholder 

The Text 
Placeholder 

Content 
Selector tools

Fig. 9.17 The Title, Clip Art, and Text slide layout 
Adding the pictures to the slides 
Slides #2 through #9 will have a graphic of a Screenbean in the Content placeholder. This job 
has to be done directly on the slide. 



ESSENTIAL MICROSOFT OFFICE XP: Tutorial for Teachers 
Copyright © Bernard Poole, Lorrie Jackson, Rebecca Randall, 2002. All rights reserved 

 
258 

You should still be in Normal view, so click on the thumbnail for Slide #2 in 
the show to make Slide 2 the current slide (you should see the large version 
of the slide in the middle of the PowerPoint window) 

Let's take a closer look at the Content Selector tools in the lower right frame of the slide (Fig. 
9.18). 

 Insert Chart 
 

 

Insert Table Insert Clip Art 

Insert Movie clip Insert Picture 

Fig. 9.18 The Content Selector tools 
As illustrated in Fig. 9.18, you can insert a table from Access, say; or a chart from Excel; or clip 
art from Microsoft's gallery of clip art; or a movie clip that you made yourself or that you 
downloaded from a CD-ROM or from the web; or an organization chart, or any picture that you 
have saved on disk. If you click on the Insert Clip Art tool, PowerPoint brings up the Clip 
Gallery (Fig. 9.19). 

 
Fig. 9.19 The Insert Picture dialog box 

The Screenbean pictures that you are going to use for this presentation are from Microsoft's clip 
art gallery, but they may not be available on your computer. So for the sake of this exercise, a 
folder has been prepared on your PowerPoint disk in which are stored the 8 Screenbean pictures 
you will use for this presentation.  You will use the Insert Picture tool in the Content Selector 
tools (Fig. 9.18 above) to put the pictures on your slides. 
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Put your PowerPoint Disk in the disk drive, then click on the Insert Picture 
icon in the Content Selector tools (Fig. 9.18) so you can add a picture from 
a file on your disk (the Confused Screenbean) 

In the Open dialog box, Open the Screenbean folder 

In the Screenbean folder there are the 8 pictures you need for the next 8 slides in the 
presentation. Table 9.1 lists the pictures in the order in which you should use them in the slides. 

Slide 2 Confused 
Slide 3 Contused 
Slide 4 Juggler 
Slide 5 Inspired 
Slide 6 Nowwhat 
Slide 7 Elated 
Slide 8 Yayyy 
Slide 9 Jubilee 

Table 9.1 The required sequence for the pictures in the Screenbeans presentation 

In the Screenbean folder, double click on the image with the name 
Confused (“Confused” with an “f”, not “Contused” with a “t”!) 

PowerPoint drops the Screenbean figurine inside the right side placeholder on the slide, with 
handles around it so that you can re-size it if necessary to fit neatly inside the borders of the box. 
You probably won't need to do this, but feel free to do so if you want. 

Check to make sure the image is correctly positioned inside the box 

Click anywhere off the image after you have it where you want it, in order to 
set it in place, then scroll down to slide #3 

You’ll need to select the Text and Content layout again, before adding the picture. 

In the Slide Layout Task Pane on the right of your screen, locate the Text 
and Content Layouts section of the Slide layouts again, and double click 
on the layout for Title, Text, and Content (Fig. 9.16) 

Click on the Insert Picture icon in the Content Selector tools (Fig. 9.18), 
then in the Open dialog box, Open the Screenbean folder and double click 
on the image with the name Contused 

Repeat this exercise for the next six slides, loading the images in the order 
they are listed in Table 9.1 above 

When you are done with slide #9, switch back to your Data Disk again and 
Save the Screenbeans document before proceeding to the next exercise 
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9.4 ADDING BELLS AND WHISTLES TO THE PRESENTATION 
Setting timings for the slides and adding transitions 
This task should be done while you are in the Slide Sorter View. 

Click on the Slide Sorter View in the Slide View toolbar, then from the Slide 
Show menu select Slide Transition... 

This brings up the Slide Transition Task Pane (Fig. 9.20). 

 

Transition 
Effects 

 

Modify the Speed 
and select a 
Sound to 

accompany a 
Transition Effect 

Fig. 9.20 The Slide Transition Task Pane (foreshortened for 

Watch the highlighted slide in the Slide Sorter while y
Transition Task Pane on any of the transitions in the
effects—try several of them to get a feel for how they wo
In the lower portion of the Task Pane, click in the
Automatically after and increase the Advance slid
seconds, but leave the check mark in the box next to On

This will allow the user to advance to the next slide either manuall
automatically (after 10 seconds). 

Finally, for a sound effect choose Drum roll (if you d
when you eventually run the slide show, it may be bec
speakers on your computer, or the speakers on your 
mute) 
Choose settings to 
assist the user in 

advancing from one
slide to another 
page layout purposes) 

ou click in the Slide 
 menu of Transition 
rk 
 check box next to 
e time to 10 (ten) 
 mouse click 

y (by clicking the mouse) or 

on’t hear a drum roll 
ause you don't have 
computer are set at 
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You are going to Apply these timing and transition effects to All the slides, but you could have 
different effects for each slide if you wanted, simply by going from slide to slide, setting the 
options, and not applying to All Slides. 

Click on Apply to All Slides 

Notice that the timing value ":10" has appeared underneath each slide in the Slide Sorter view. 
Choosing Slide Designs 
PowerPoint gives you all kinds of assistance in the design of your slides.  So far we've used the 
Slide Layouts which give you lots of help with the general layout of each slide in your show.  
But the Slide Design Task Pane lets you select from an extensive set of pre-formatted options 
involving graphics, colors, and animations. Let's check some of these options out now. 

Stay in the Slide Sorter view, and in the Format menu select Slide Design... 
The Task Pane now changes to the Slide Design Task Pane (Fig. 9.21). 

 
Fig. 9.21 The Slide Design Task Pane 

At the top of the Slide Design Task Pane (Fig. 9.21), you have three design choices. You can use 
Design Templates, Color Schemes, Animation Schemes, or a combination of all three.  Let's 
examine each in turn and see how they work together to help you prepare eye-catching, visually 
engaging slides. 
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Design Templates 
The easiest way to make your slides more interesting is to use one of the pre-set Design 
Templates that come with PowerPoint. You can select from quite a large set of Design 
Templates, most of which are very attractive. Let's try some of them now. 

If necessary, scroll in the Task Pane, and hover (don't click yet) over a 
Design Template that appeals to you 

As you hover, you'll see a small grey bar appear on the right side of the Template with a 
small down arrow on it (Fig. 9.22). 

 
Fig. 9.22 The Design Template pop up menu 

Click on the down arrow, then, in the menu, click on Apply to All Slides 
If you wanted to apply the Design Template to just a few slides, you would first select the slides 
you want, then click on Apply to Selected Slides. Let's try that. 

Hold down the ctrl key while you click on three or four of the slides in the 
show 
Now, in the Task Pane, hover over a Slide Design Template different than 
the  one you chose before, click on the down arrow and, in the pop up menu, 
select Apply to Selected Slides 

You see how easy it is to create a diversity of quite attractive slides. 
PowerPoint is a beautiful program because it's so easy to use once you know what's available 

to you.  You can really go to town when you're designing slides, as long as you know about all 
the tips and tricks—the bells and whistles— offered by the software. 
Color Schemes 
You may well like one of the Slide Design templates you were just working with, but you didn't 
select it because the Color Scheme wasn't what you were looking for.  Well, you can do 
something about that by using the standard Color Schemes or, if you want to choose your own 
colors, you can go with a custom Color Scheme.  Let's try some of the standard Color Schemes 
first. 

Click on any slide, then in the Task Pane, click towards the top on the Color 
Schemes option 
Scroll if necessary and hover over one of the Color Schemes, click on the 
down arrow and, in the pop up menu, select Apply to All Slides 
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Choose any Color Scheme you like from those displayed—try a few of them 
to see how they look 

Just as for the Design Templates, you don't have to apply a Color Scheme to all slides.  You can 
select one or more of the slides and apply the Color Scheme to those alone. 

Each new installation of PowerPoint starts out with a limited set of standard Color Schemes, 
and there may be none that you particularly like. Color is, after all, a very individual thing. 
Customizing a Color Scheme is easy enough, however, and if you put together a Color Scheme 
you really like, you can add it to the set of standard Color Schemes. 

In the Slide Design Task Pane, click to select one of the standard Color 
Schemes then, at the bottom of the Task Pane, click on Edit Color 
Schemes… 

Fig. 9.23 shows the Edit Color Scheme dialog box. 

 

Fig. 9.23 The Edit Color Scheme dialog box 

Make sure you have the Custom tab selected, click on any of the small 
color boxes (next to Background, Text and Lines, etc.), then click on the 
Change Color… button (Fig. 9.23) to select from a palette of either 256 
colors (the standard color palette) or from over 16 million different colors (the 
custom color mixer) 

Take whatever time you need to familiarize yourself with these color selection tools.  You may 
recall learning about them in Lesson 3 when you practiced using the Office Drawing Toolbar. 

After you have selected some new colors for this and that, check it out by 
clicking on the Apply button (Fig. 9.23 above) 
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Animation Schemes  
Animation refers to movement.  A PowerPoint animation scheme controls how text and other 
slide objects emerge onto the screen during a presentation—sliding in from the right or left, or 
fading in, and so forth. Let's try some of the Animation Schemes now. 

In the Task Pane, click towards the top on the Animation Schemes option 
The Animation Schemes Task Pane comes up in the left hand frame (Fig. 9.24). 

 
Fig. 9.24 The Animation Schemes Task Pane 

Try out some of the Animation Schemes by clicking on them one by one, then 
click on the Apply to All Slides button 

Just as for the Design Templates and the Color Schemes, you don't have to apply an Animation 
Scheme to all slides.  You can select one or more of the slides and apply the Animation Scheme 
to those alone. If you really wanted to create completely customized slides, you could choose 
Background from the Format menu in order to select from a wide range of colors and Fill 
Effects, including gradients, textures and patterns (Fig. 9.25).  

 
Fig. 9.25 The Background dialog box 
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Using the Fill Effects Option in the Background dialog box (Fig. 2.25), you can even use your 
favorite pictures as backgrounds for your slides. You can individualize each slide in this way, or 
apply the same design features to all the slides. 

Try to find the time to experiment with these background Colors and Fill Effects. It is beyond 
the scope of this tutorial to introduce you to all the features of the PowerPoint program.  What 
you can do is limited only by your imagination... 
Making the images transparent 
One problem still remains to be fixed before we move on. If you selected a design template with 
a background other than white, the Screenbean images, with their white background, look odd 
against the slide background. Here's how you can fix this. 

Click on the thumbnail for Slide #2, to bring the full slide up so you can work 
with it 
In the large version of the slide in the middle of the window, right click on 
the Screenbean image, then, in the pop up menu, select Show Picture 
Toolbar 

The Picture Toolbar is displayed on the screen (Fig. 9.26). 

 
The Set 

Transparent 
Color tool Fig. 9.26 The Picture toolbar 

Click to select the Set Transparent Color tool in the Picture toolbar (Fig. 
9.26), then simply click on the white background of the Screenbean picture 

Hey presto! Screenbean picture's transparent. 
Now do the same with the Screenbean pictures on the other slides 
Save the Slide Show when you're done 

Checking out the presentation 
It’s time to try out your show. 

In the Slide Show menu, select View Show and click your way through each 
slide at your own pace, or let the computer time it for you, 10 seconds per 
slide 

 

9.5 ACTION BUTTONS AND HIDDEN SLIDES 
Action buttons 
Action Buttons allow you to control the sequencing of the slides in a slide show. They also allow 
you to go to slides that would otherwise be hidden from the user’s view and passed over when 
the slide show is running. 

The Action Buttons can also be used to direct the user back to a previous slide, or forward to 
the next slide, or to go directly to the first or last slide. There are other buttons that can be used 
to call up a movie clip or some other kind of document. 
You're going to put Action Buttons on each slide, other than the first and last slide, which will 
allow the user to go back to the previous slide or forward to the next slide. The first slide will 
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just have one Action Button to go to the next slide, and the last slide will have two Actions 
Buttons, one to go to the previous slide and one to go back to the beginning on the show (Home). 
Fig. 9.27 shows you how the Title slide will look after you've added the Action Button. 

 

Here's the 
action button 

Fig. 9.27 The Action Button on the Title slide 

Here goes. To use Action Buttons you must be in the Normal view. 

In the Slide View toolbar click on Normal view, make sure you have the 
Slide tab selected at the top of the left hand pane, then click on Slide #1 
(the Title slide) 

In the Slide Show menu, select Action Buttons and from the Action 
Buttons panel (Fig. 9.28) click the Action Button for Forward or Next slide 

 

Fig. 9.28 The Action Buttons panel 

Now, without clicking, roll the mouse cursor down over the slide and notice 
that the arrow pointer changes to a cross hair 
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Position the cross hair in the lower right corner of the slide, then hold 
down the left mouse button and drag to create a box about a half inch 
square 

Let go of the mouse button when you're done 

PowerPoint displays the Action Settings dialog box (Fig. 9.29). 

 
Fig. 9.29 The Action Settings dialog box 

You want the Action Button to go to the Next Slide after the Title slide, which 
is the default hyperlink in the Action Settings dialog box which pops up on 
your screen, so click on OK 

You should now see a professional-looking Action Button which, if you ran the slide show right 
away and clicked on the button, it would advance you to the next slide. 

You can adjust the size of the Action Button if you want by dragging on the 
handles around the button 

On the next eight slides, you're going to put two action buttons in the lower right corner, next to 
each other—one to go back to the previous slide and the other to go forward to the next slide. 

Click on the thumbnail for Slide #2 to make it the current slide 

In the Slide Show menu select Action Buttons, and from the Action 
Buttons panel click the Action Button for Back or Previous slide 



ESSENTIAL MICROSOFT OFFICE XP: Tutorial for Teachers 
Copyright © Bernard Poole, Lorrie Jackson, Rebecca Randall, 2002. All rights reserved 

 
268 

Move the cursor down to the lower right corner of the slide and drag to draw 
an Action Button towards the lower right corner, but leaving room to the 
right for a second button to be placed next to it in the lower right corner (Fig. 
9.30) 

Slide #2 will look something like Fig. 9.30. 

 
Fig. 9.30 Slide #2 with the Action Buttons in place 

You want this first Action Button to go to the Previous Slide, which is the 
default hyperlink in the Action Settings dialog box which pops up on your 
screen, so click on OK 

Still on Slide #2, in the Slide Show menu select Action Buttons, and from 
the Action Buttons panel click the Action Button for Forward or Next slide 

Move down over the slide and drag to draw an Action Button in the lower 
right corner of the slide, right next to the Action button you just created 

Once again, you want the Action Button to go to the Next Slide, which is the 
default hyperlink in the Action Settings dialog box, so click on OK 
Feel free to resize the action button if necessary 

Copying the Action buttons to other slides 
Once you have created a set of buttons for a slide, if you need to do the same on other slides in 
the presentation, all you have to do is copy and paste them.  This is a lot quicker than recreating 
them on each succeeding slide.  This is simple to do. 

Hold down the Shift key on the keyboard then click on each of the new 
buttons on the Confusion slide so that both buttons are selected 

Press ctrl-c on the keyboard to copy them to the clipboard 

Click on the thumbnail for slide #3 and press ctrl-v to paste the buttons onto 
the slide 

Notice that the buttons are pasted into the exact same place on the next slide. 
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Now do the same for the remaining slides in the presentation 
The Acknowledgments slide 
Many of the slide shows you or your students create will have information or pictures in them 
that come from some source other than your own. So you need to acknowledge your sources. 
The best place to do this is on the last slide in the show. Let’s do that now. 

In the left hand pane, click on the thumbnail for the last slide, then from the 
Insert menu select New Slide 

The default slide layout is the Title and Text layout, which is what you want 
for this last slide, so click where it says Click to add title and type the word 
Acknowledgments 

Click where it says Click to add text and type All images in this 
presentation are from Microsoft’s Clip Art Gallery 

The buttons are slightly different on the last slide.  You want a button to go back to the previous 
slide still, but instead of a button to go forward to the next slide, you need one that takes you 
back to the beginning of the show. This is called a Home Action Button. 

Make sure you are still on Slide #10 (the Acknowledgements slide), the last 
slide in the show, and add two Action buttons in the lower right corner (a 
Previous Action Button and an Action Button for Home (the second button in 
the panel of Action Buttons in the Slide Show menu) 

Your show is almost ready, but first you’d better once again save what you’ve done so far. Now 
you have to learn about hidden slides. 
Hidden slides 
Hidden Slides are slides that will be bypassed as the user clicks through a presentation except 
when the user clicks on an Action Button that specifically sends them to the Hidden Slide. 

Here are the steps to create an Action Button on one slide which will step the user to a 
specific Hidden Slide in the slide show. 

Make sure you still have the Slide tab selected at the top of the left hand 
pane so that you can see all the thumbnails of your slides, then click on 
Slide #2 (the Confusion Screenbean slide) 
Click to position the cursor right at the end of the text that you typed in the 
slide’s text placeholder (lower left on the slide, after the words …tougher 
than it really is) 
Hit Enter, then type Click if you’d like to read a quote about problem-
solving 
From the Insert menu, select New Slide (ctrl-M) to insert a new slide right 
after Slide #2— the Confusion slide 

Immediately, PowerPoint inserts a new slide right after the second slide in the show. 

Next, in the Slide Layouts Task Pane on the right of your screen, locate the 
Title slide layout and click to select it as the layout for the new slide 

You want this new slide to be a Hidden Slide. 
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In the Slide Show menu, select Hide Slide 
Click in the title placeholder on the new slide (where it says Click to add 
title), and type the following quotation: “Quality is in the details.” 
Click in the subtitle placeholder on the new slide and type the following 
“Bernie Poole, Esq.” 

The Hidden Slide with the quote on it is now ready. All you have to do now is tell PowerPoint 
how to find it. 

In the left hand Task Pane, click on the thumbnail for Slide #2 (the 
Confused Screenbean) 
In the Slide Show menu, select Action Buttons and from the Action 
Buttons panel click the Action Button for Forward or Next slide 
Again, without clicking, roll the mouse cursor down over the slide and notice 
that the arrow pointer changes to a cross hair 
Position the cross hair below the text that you typed in the slide’s text 
placeholder (below " Click if you’d like to read a quote about problem-
solving"), then hold down the left mouse button and drag to create a box 
about a half inch square 
Let go of the mouse button when you're done 

PowerPoint displays the Action Settings dialog box (Fig. 9.31). 

 

Click on this 
down arrow 
to bring up 
the menu of 
hyperlink 
options 

You want the 
Slide… 
option 

Fig. 9.31 The Action Settings dialog box 
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The default Hyperlink is to the Next Slide and this is not what you want, so 
click on the arrow to the right of the box (Fig. 9.31) to show the drop down 
menu of Hyperlink options 
Choose Slide... from this drop down menu 

Now you will see a list of the slides you have just made (Fig. 9.32). 

 
Fig. 9.32 The Hyperlink to Slide dialog box 

Select slide #3 (“Quality is in the details.”) and click on OK, then click on OK 
again 

This new Action Button now provides a link to slide #3 from slide #2 in the show. When you run 
the show in a moment, if you do not click on this Action Button, slide #3 will remain hidden and 
will be bypassed. 
Changing an Action Button's colors and effects 
The last thing you might like to do with the button is change its color scheme so it stands out 
from the regular buttons that are already on the slide. This way the Action Button will more like 
draw the user's attention. 
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To do this you simply double click on the Action Button and you’ll be presented with the 
Format AutoShape dialog box (Fig. 9.33) in which you can select from a wide range of colors 
and other effects. 

 

Use these 
tools to select 
more Colors, 
Fill Effects, 

or 
Backgrounds 

Fig. 9.33 The Format AutoShape dialog box 

Try this now--double click on the Action Button and experiment with colors 
and effects of various kinds, clicking on OK each time you want to see how a 
particular color or effect looks 
Click on the down arrow in the Color: box to see the color palettes and other 
Fill options 

Your last job for now is to put an Action Button on the Hidden Slide, too, to help the user 
proceed to the next slide in the show. 

You should know how to do this on your own, so go ahead and create an 
Action Button which the user can click on to proceed to the next slide 

Finally, from the Slide Show menu select View Show to see how your 
presentation looks with this new feature incorporated into it 

You could link to any of the slides in the slide show, or you could link to other documents and 
images stored elsewhere. The potential for variation is infinite. 

You can perhaps see how using Hidden Slides and Action Buttons to link to them, you could 
easily (with a little time) create presentations which would act as tutorials, assessment tools, and 
so forth. 
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It is beyond the scope of this tutorial to step you through the process of developing such 
applications, but in the Skills Consolidation section at the end of this lesson there are some 
exercises along these lines for you to work on. Then, in Lesson 10 you’ll have the opportunity to 
reinforce the skills you’ve learned in this lesson and take a crack at creating an interactive slide 
show which will extend your skills beyond the basics. 
 

9.6 PRINTING PRESENTATION HANDOUTS 
A nice feature of PowerPoint is its ability to provide you with hard copy versions of the slides 
and/or of the outline text of a presentation. This is useful for the preparation of handouts for an 
audience or a class. Here are the steps to do this. 

From the File menu choose Print, then click on the Print what: drop down 
menu in the lower left corner of the Print dialog box (Fig. 9.34) 

 
Fig. 9.34 Selecting handout options for printing 

In the Print dialog box, from the Print what: drop down menu select the 
option Handouts, also click in the box in the lower left of the Print dialog box 
to tell PowerPoint to print the slides in Pure Black and White, then click on 
OK to print a copy of the presentation 

In the handout options, you can choose two, four, six, or nine slides per page, and you can 
display the slides in order either horizontally or vertically. This handout can then be distributed 
to an audience or a class for note-taking, review or reinforcement. 
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Before you finish, why don't you go ahead and make a backup copy of your 
Screenbeans presentation on your Data Disk Backup? 

 

LOOKING BACK 
Lesson 9 has been devoted to the PowerPoint program that is designed to help in the preparation 
of presentation materials of all kinds. It is not only a very useful tool, but also it is enjoyable to 
work with. Outlines and slide shows will add polish to the lessons or presentations you will 
prepare for your students and other groups during the course of your career. For example, a math 
or chemistry teacher might intersperse her lessons with professional-looking formula charts or 
chemical structures. Any teacher could make an impressive graphic introduction to a class. An 
administrator could do the same for her school, the presentation to be viewed in the office by 
visitors.  

But PowerPoint is still more valuable as a tool for learning in the hands of your students.  
They will soon learn the necessary skills to use the program with flare and they'll creating 
presentations of their own.  As their teacher, you'll guide them in the direction of learning 
projects of all kinds related to the curriculum K-12.  In the context of PowerPoint, students will 
discover knowledge and construct their own mental database of information that will stand them 
in good stead in their future lives. 

 

LOOKING FORWARD 
PowerPoint is a useful teaching tool, providing added value for both the teacher and the 
students. A carefully prepared and well-designed presentation, appropriately used during the 
course of a class, helps the teacher stay focused and on track. A presentation that is rich in 
multimedia gives the teacher the opportunity to spice up presentations in various ways that 
promote added interest and engagement for students. PowerPoint also can be used to create as 
well as enable powerful learning environments. 

Lesson 10 will show you how to create interactive presentations in which the user learns 
while responding to the material that is being presented, thus encouraging engagement, which 
promotes learning. More powerful yet, PowerPoint may be best used in the discovery mode of 
learning, where the students create presentations that involve research in the pursuit of 
knowledge, incorporating multimedia—still images, video, and sound, along with text—in the 
construction of a personal understanding of the subject matter being learned. 

A thoughtful teacher will encourage her students to work together on such projects and 
present their work to the class, thus applying the adage that the best way to learn is to teach. 

As the saying goes: "I hear and I forget, I see and I remember, I do and I understand."  
 

SKILL CONSOLIDATION 
1. Prepare a presentation on the subject of the American colonies. Make sure you have at least 

five first level topics (five slides). 
2. Prepare a presentation on the subject of US Presidents (or any subject of your choice that you 

might use with a K-12 age group appropriate to your major). Make sure you have at least five 
first level topics (slides). Use the Hidden Slide feature and Action Buttons to ask a question or 
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questions about the subject matter of the presentation. So you would ask a question on one 
slide (True/False or Multiple Choice, for example), then have Action Buttons on the same 
slide which would link to the Hidden Slides that have the answer (Correct or Incorrect) to the 
question. On the Hidden Slides you would then have an Action Button which would link to 
the next question or the next slide in the presentation. 

3. Prepare a presentation on the subject of the American movie scene. Make sure you have at 
least five first level topics. Use the Hidden Slide feature and Action Buttons to ask questions 
about the subject matter of the presentation. So you would ask a question on one slide 
(True/False or Multiple Choice, for example), then have Action Buttons on the same slide 
which would link to the Hidden Slides that have the answer (Correct or Incorrect) to the 
question. On the Hidden Slides you would then have an Action Button which would link to 
the next question or the next slide in the presentation. 

4. Prepare a presentation in a style of your own choosing with at least three levels on the subject 
of contemporary music. Make sure you have at least five first level topics. Use the Hidden 
Slide feature and Action Buttons to ask questions about the subject matter of the presentation. 
So you would ask a question on one slide (True/False or Multiple Choice, for example), then 
have Action Buttons on the same slide which would link to the Hidden Slides that have the 
answer (Correct or Incorrect) to the question. On the Hidden Slides you would then have an 
Action Button which would link to the next question or the next slide in the presentation. 

5. Create a slide show with yourself as the subject--you the person, you the teacher. Use 
graphics drawn from any source you like. 

6. Create a slide show on the subject of pets. Use graphics from clip art or created in a Drawing 
or Painting environment. Make sure you have at least five first level topics. Use the Hidden 
Slide feature and Action Buttons to ask questions about the subject matter of the presentation. 
So you would ask a question on one slide (True/False or Multiple Choice, for example), then 
have Action Buttons on the same slide which would link to the Hidden Slides that have the 
answer (Correct or Incorrect) to the question. On the Hidden Slides you would then have an 
Action Button which would link to the next question or the next slide in the presentation. 

7. Create a slide show on the subject of geometric shapes. Use graphics drawn from clip art or 
created in a Drawing or Painting environment. Use the Hidden Slide feature and Action 
Buttons to ask questions about the geometric shapes. So you would ask a question on one 
slide (True/False or Multiple Choice, for example), then have Action Buttons on the same 
slide which would link to the Hidden Slides that have the answer (Correct or Incorrect) to the 
question. On the Hidden Slides you would then have an Action Button which would link to 
the next question or the next slide in the presentation. 

 


